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Logging into WebEOC 
 

Two ways to find the WebEOC login: 

1. Perform a search for “WebEOC San Diego” in a standard web browser.   Or,  
2. Go to the Office of Emergency Service page on the County of San Diego Website.   

 
 

Click on the blue Direct WebEOC Login link: 
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3. At the login screen, enter your first name, add a space, and then your last name 
 

 
 
 

4. Enter your password.  If this is your first time logging in, your temporary password will be 
Newpass1$.   Once you log in, you will be prompted to change your password. 

5. If you forgot your password, click on the “Forgot Username/Password?” link and follow the 
instructions (Note:  if you have not logged in to WebEOC within a 365-day period, your 
account will be locked.   Please contact the OES WebEOC administrator to unlock the account).  
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6. When you login, your role (position) will be displayed by default.   
7. The default Incident is currently set to “***Training Incident 5***.”   During an activation, the 

default incident will be set appropriately. 

 

 

TIP:  The incident can be selected from the dropdown.  You can use ***Training Incident 5*** at any time 
to practice your WebEOC skills. 

 

Security Notes: 

1. WebEOC requires complex passwords.  Passwords must be a minimum of 8 characters in length 
and must contain at least one upper case letter and one special character.   

2. Passwords expire every 90 days 
3. Users who have not logged in within a 365-day period, must have their account unlocked by the 

WebEOC Administrator (WebEOC@sdcounty.ca.gov) 
4. Accounts that have not been used (logged into) within a 2-year (730-day) period will be 

removed.  The account can be re-instated by contacting the WebEOC Administrator 
(WebEOC@sdcounty.ca.gov) 
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8. Click Continue.  The Welcome screen is displayed 
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Navigating the Menus in WebEOC 
 

 

 

Note:  The settings menu is only available to administrative roles. Please see your OES WebEOC 
administrator if you need additional permissions 

1. The Incident field is a dropdown.   Incidents can be set to “Default” so that they automatically 
appear at login as the assigned incident.   Outside of a formal exercise or actual event, the 
Default Incident will be “Training Incident 5.” 

a. If the default incident is incorrect, the correct incident can be selected from the 
dropdown.  All active incidents will be presented in the list. 

 

 

 

  

Admin Profiles:   WebEOC allows authorized non-administrative users the ability to add Incidents, 
create users, assign positions and reset passwords.   Your agency’s WebEOC lead can authorize this 
change by contacting the OES WebEOC administrator. 
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2. The Position field is a dropdown.  Users will see and access the positions they have been 

assigned.  Positions also determine which boards the user will be able to access (see examples 
below): 

SHF DOC Coordinator Boards: 

 

SHF 911 Dispatch Boards: 
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a. The position can be changed by selecting the desired position from the dropdown. 
3. The Navigation (Control) panel provides access to all assigned boards and resources.   
4. As boards and resources are selected, a tab is added horizontally on the menu bar so that the 

user can easily switch between boards and resources.  The active page is indicated by a dark 
gray tab 

a. Remove a tab from the menu by clicking on the “X” on the tab 
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5. Click the Home          tab to return to the home page 

 

 
6. A shortcut button (upper right corner) is provided as an alternative way to navigate between 

boards.  Select the desired tab from the dropdown list. 
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Boards 
Posting to the Primary (Local) Event Log (Board) 
 

1. Click on the Navigation (Control) Panel.  Select the Primary Event Log (board) for the current 
position assigned (Item #1).  In this example, the Primary Event Log for SHF DOC Coordinator is 
the Sheriff Events Log: 

 

Note:    

• The star   symbol indicates that something in the event has changed since the user last 
accessed the page.    

• The right-arrow takes the user directly to the event board.  The user may also double-Click on 
the desired board  

The selected board is presented below: 

 

 

 

2. Click the New Entry                  button. 
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Tip:  The ideal description is six (6) lines in length.  The description can be cut and pasted from another 
source.  However, content exceeding six (6) lines will not be visible to the reader. 
 

3. The following fields are pre-filled (and are read-only) for each board entry: 
a. Current Date (and time) 
b. Name 
c. Position 

4. The Event/Subject is a required field 
5. Select a Priority from the dropdown.  Priority must be based on the following criteria: 

a. High- Life Safety/Mission Critical 
b. Medium- Injury/Property/Environment 
c. Low- Information 

Priorities are displayed on the events board using color coding.  For example, Red will depict 
High-priority events.  Yellow will depict Medium-priority events and Green will depict Low-
priority Events.   

6. Enter an Information Source (From where or whom this information was provided) 
7. Enter a Description 
8. Click the Choose File button to attach a file to the event.  

 
Tip:  One attachment is permitted per post.  However, several files per post is possible by uploading a 
zipped file using a Zip tool. 
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Editing, Updating or Removing an Event 
 

An event can be edited, updated or removed by clicking the Edit/ Update/Remove button (right side of 

the event in the list):   

 

Note: WebEOC preserves previous entries.  Note that the original Description entry above is Read Only.   

1. The following fields can be updated: 
a. Event/Subject 
b. Priority 
c. Information Source 

2. A new Entry/Update Description can be added.  Once saved, it will append to the original 
Description entry 
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3. Click Update to update the changes. 
4. Click the Save button (upper left) to finalize the change and post the update 

 

 

5. To remove the entry, click the Remove Item checkbox  to remove the 
Event and then click the Save button (noted above) to finalize the change and post the update.   
 
Note: Some roles may not have permission to remove an event.  
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Posting an Event to a Regional Board (Not available for all organizations or positions) 
 

In some cases, an event recorded on the Primary Board will be significant and urgent enough to require 
that it be shared with a broader audience.    When this is determined, the event can be shared by 
updating the event: 

Note:  In General, each user is empowered to post an event regionally at their own discretion (e.g. a 
high-priority event).  However, your team may have specific policies to follow.  

 

 

In this example, it has been determined that this event should be shared with a broader audience.   

 

1. Edit the event that should be shared by clicking on the Edit/ Update/Remove button (right side 

of the event in the list):   
2. Locate the available share button or buttons on the top right of the screen.  In this example, 

there are two boards available with which to share this event, Regional Significant Events and 
Law Enforcement Hub.    

3. Click the checkbox for one or both of the boards and click the save button.  
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4. The event will now appear on the Regional Significant Events and Law Enforcement Hub Boards: 

 

 

 

 

Note:  Only OES Staff Duty Officers can remove a post from the Regional Significant Events Log. 

 

 

Search Function 
WebEOC provides a keyword search function for each board.  Enter a key word in the Search box and 
click the Search button  

 

All events containing the key word will be displayed (filtered) on the board.  To clear the search word, 
click the Clear button.  
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The Event Toolbox 
 

As events are added to the board, it will become necessary to sort and organize the information.   An 
Event Toolbox is provided to help organize and report event information.   The functions available on 
the Toolbox differ by board and user permissions.  The Toolbox is located in the upper right corner of 
the screen. 

The following toolbox is presented on the Events Log: 

 

The following toolbox is presented on the Regional Significant Events Log: 

 

The following toolbox is presented on the Hub Log : 

 

 

Each function in the toolbox is accessed by clicking on the function description (an active link). 

 

Basic Functions include: 

1. My Entries-This will provide a listing of all events entered by the user 
2. Create Report-  This will create a summary of all events entered on the board   

a. Click on the Create PDF button to create a PDF report of the entire board. 
b. Click on the Back button to return to the board 

c. A new entry can be made on this page by clicking the Add Record link   
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Figure 1 Create Report 

 

3. Lg Font- This function displays all events on the board in a larger font size for easier viewing (or 
viewing on a display at a distance).     

a. A new entry can be made on this page by clicking the Add Record link   
b. Click the Back button to return to the board. 

4. Removed- Displays all removed events 
5. Dashboard- Each board has a predefined dashboard.  In this example, the Sheriff Event Log user 

can view both the Sheriff Event and Law Enforcement Hub boards simultaneously.  A chat 
window tool is provided in the left margin.  

a. A new entry can be made on this page by clicking the Add Record link   
b. Click the Back button to return to the main board. 

 

 

Figure 2 Dashboard 



20 
 

6. View By- Allows the user to filter the board by priority.  For example, to display all High-priority 
items. The dropdown will present all available priorities (i.e. if no high-priority items have been 
entered, the value will not be presented as a dropdown option). 

7. View by City- This function is available in the Regional significant events page.  It allows the 
user to filter events by City. 

 

 

Slideshow Presentation Mode (Full Screen Mode) 
 

WebEOC is capable of displaying open event boards in a slideshow presentation mode.   

 

Click the  icon (next to the Incident name in the menu bar) to hide the menu bar.  Review the tool 
bar at the bottom of the screen  

 

 

 Click to Play       Move one board backward 

 Pause                  Move one board forward 

Speed:  The speed of the presentation can be adjusted (Right is faster speed.  Left is slow speed).  Play 
must be pressed first to adjust the speed 

  Exit Presentation Mode 
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Phone List 
 

WebEOC provides at tool to post phone numbers and phone lists for organizations.  The phone list 
function is independent from any incident and will always appear as an option in the Navigation Panel.  

Note: Each organization is responsible for updating their own phone list.  

 

To access the phone list, select it from the Navigation (Control) Panel: 

 

Organizations are listed in alphabetical order.  The user searches for a phone list either by scrolling to 
locate the list or by entering search terms in the search box: 
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Figure 3 Phone List 

 

Phone numbers can be listed for an individual or an entire organization.   

1. To provide a phone list for an organization, click the Browse button to upload the file.   The 
attachment can be either a Microsoft file (Word, Excel, etc.) or a PDF. 

a. Click Save to save the entry, or Cancel to cancel the entry. 

 

Figure 4 Phone List Record 

2. Phone list attachments for organizations can be accessed by clicking on the attachment icon for 
the listed organization: 
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3. The phone list record and any attachments can also be viewed and downloaded by clicking the 
View button for the listed organization.  

4. A phone list can be edited and updated by clicking the Edit button for the listed organization 
5. A phone list can be removed by checking the Remove from List checkbox within the phone list 

record   
6. Removed phone lists can be viewed by clicking the View Removed Entries at the bottom of the 

page.   

Task Tracker 
 

The Task Tracker board is used to request and fulfill supply orders through the Logistics team.  The 
board has been designed to capture all required information necessary for reporting to FEMA for 
reimbursement.   

Note:  The Task Tracker must not take the place of face to face communication with the Logistics team 
for coordination.  

To access the Task Tracker, select it from the Navigation (Control) Panel 
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The current list of requests for the assigned incident is presented: 

 

Figure 5 Task Tracker/Logistics Request 

As with other boards, a search can be performed using the search tool, or by scrolling through the list of 
requests. 

Roles:   
Requester/Originator- enters details about the request.  Noted in grey 

Logistics- updates the request.  Noted in black 

Finance- Submits payment for the request.  Noted in green 

 

1. To enter a request, click the New Entry button. 
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Figure 6 Originator (Requester) Screen 

2. Prefilled items include: 
a. Originator Name 
b. Originator Position 
c. Date and Time 

3. The Assigned to field is mandatory.  It indicates a local position assignment.  The default value is 
the first position in the list.  Select the correct position from the dropdown. 

4. Assign a priority: 
a. Low= item (s) needed in 6-12 hours 
b. Medium= item (s) needed in 2-6 hours 
c. High= item (s) needed within the next hour 

5. If the request pertains to a fire agency, the Incident Number is entered 
6. The details of the request are provided in the Subject, Quantity, Size and Detail field 
7. A justification is entered 
8. A shipping location and address is provided 
9. A Point of Contact and Point of Contact telephone number is entered 
10. Attachments can be uploaded to the request by clicking on the Browse button and selecting a 

file 

WebEOC tracks the time the request was assigned, calculates when it is due and records when the 
request has been completed.  

11. Click the Save button to save the request and send it to Logistics 

Note:  WebEOC generates an audible alert (three (3) beeps) to let nearby teams know that a Logistics 
Request has been entered.    
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The image below shows the fields Logistics must complete to fulfill the request.  To access a request, the 
Edit button is clicked for the desired request. 

 

 

 

Figure 7 Logistics Screen (Part 1) 

Fields next to Donation, Quantity Ordered and Unit Cost: 

 

Figure 8 Logistics Screen (Part 2) 

Once the information is completed by Logistics, the request is saved and routed to Finance. 
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The image below shows the fields Finance must complete to fulfill the request: 

 

Figure 9 Finance Screen 

Once the information is completed by Finance, the request is saved and completed. 

 

The status of a request is visible throughout the lifecycle on the Task Tracker dashboard: 

 

 

Requests and Tasks can be filtered by using the All Tasks dropdown in the upper right corner of the 
board.  Filters include:  All Tasks (from every board member).  My Requests (what the user on the board 
has entered).   My Tasks:  A request becomes a task for the Logistics and Finance positions. 

 

All Requests and Tasks can be printed by clicking the [Print] icon in the upper right order of the board.  
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Maps 
 

WebEOC provides access to the Emergency Map.  To access the map, select “Default Incident Map” from 
the Maps menu 

 

As OES GIS updates the incident map, it will be posted on this tab.   The map will include but will not be 
limited to the following types of information: 

1. Fire Perimeters 
2. Localized Hazards  
3. Traffic Control 
4. Evacuation Centers 
5. Recovery Centers 
6. Evacuation Routes and Perimeters 
7. Current weather images (NOAA) 
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Menus 
Status Boards 
 

Other Status Boards are available to certain positons.  To see available boards, expand the list of Status 
Boards by clicking on the right arrow.     

 

 

Access the desired board by clicking on the board name or clicking the right arrow icon.   

 

 

Click the down arrow to collapse the list.   
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Dashboards:  Contracted Cities 
 

This menu allows the user to view their primary dashboard with that of a contracted city simultaneously.  
In the example below, the Primary dashboard is for the Sheriff DOC and the selected city is Poway: 

 

 

 

Incident Action Plan (IAP)  
 

The Incident Action Plan (IAP) contains two items: 

1. IAP Published Reports 
2. IAP Working Draft 

The IAP document is created and edited in the IAP Working Draft tab.  The IAP consists of six (6) 
sections: 

1. IAP Cover Sheet 
2. Incident Objectives 
3. Organization Assignment List 
4. Incident Radio Communication Plan 
5. Medical Plan 
6. Organizational Chart 

A screenshot of the IAP Main View within the Working Draft is presented below:  
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1. Each section can be accessed by clicking on the View button 
a. Within each section, the user can Edit, Print or return to the main menu by selecting the 

appropriate button at the top of each page (see the example below) 

 

 

Note:  Header information for the IAP Cover Sheet can be entered and edited by clicking on the Add 
Record link on the upper right of the screen of any template in the plan.  Values entered here appear on 
all report templates. 

 

 

2. The entire IAP can be viewed and/or printed by clicking the View/Print IAP button  
3. An Operations Branch can be viewed or created by clicking on the Operations Branch Setup 

button   



32 
 

 
a. The IAP can be published by clicking on the Publish button (see below) 

 

Once published, the IAP will be viewable on the IAP Sheriff Published Reports tab. 
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Regional Tools 
 

Acronyms 
 

The Acronyms tab contains guidelines and definitions for using WebEOC.  Links are provided for the EOC 
Checklists and a Tutorial (Note:  These documents appear to be quite dated).   

 

 

  

A partial list is shown 
here. A complete list of 
Groups is provided on 
the next two pages.  
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Group Identifiers 
 

The tab also contains Group Identifiers with their associated acronym (see sample image below): 
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FEMA Forms 
 

The following FEMA forms are available from the FEMA Forms menu: 
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ICS Forms 
 

The following ICS forms are provided in the ICS Forms menu: 

 

 

News Release and other WebLinks can also be access from this menu. 
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Tools 
Messaging 
 

WebEOC provides an internal messaging tool similar to Electronic Mail (E-Mail).   

Sending a Message: 
 

1. Click on the Messaging Link in the Tools menu (or click the right arrow icon) to access the Inbox 

 

 

 

Messages can be sent to users, positions or groups.  The Inbox will display all incoming messages for the 
user according to position and group assignment.  

2. To compose a new message, click on the green +Compose New Message box (upper right 
corner) 

 

3. Indicate the recipient of the message by clicking on  
a. Users (to send to specific user or users): Click on the +Users link and then enter the 

name of the user (Full name or partial).  Click Filter.   WebEOC will return results for all 
possible matches. 
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b. Check the box next to the desired user, then click Add 
c. The user will be added to the recipient list 

 

d. Repeat the process for any additional users.   

These steps are the same for adding Positions and Groups as recipients. 

4. Enter the desired message format by clicking the applicable check box (Generate Email; 
Generate Mobile) 

5. Enter a Subject 
6. Enter the message into the Body field. 
7. Click the Choose File button to attach a file (Optional) 
8. Click the blue Send Button to send the message or Click the Cancel link to cancel the message 

 

Reading and Replying to Messages: 
 

1. View incoming messages in the inbox 

 

 

2. Locate the desired message in the list.   Hover the mouse over any column entry in blue lettering 
and click on it to open the message 
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3. To print the message, click on the Actions dropdown (upper right) and select Print  

 

 

4. To Reply, click the reply button and enter a response.  Click Send 
5. To Forward the message, click the Forward button and follow the same steps as with sending a 

message.   
6. Click Cancel to close the message and return to the Inbox.   

 

Viewing Sent Messages 
 

1. Access the Inbox 
2. Click on the Sent Items link 
3. All Sent messages will be displayed 

 

Viewing Deleted Messages 
 

1. Access the Inbox 
2. Click on the Deleted Items link 
3. All Deleted messages will be displayed 

 

Note: The messaging tool provides no alerts when messages are received.  Users must periodically check 
the inbox to review incoming messages.  This is not as effective as using other forms of messaging (text, 
Outlook, etc.).  For this reason, this tool may be discontinued. 
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Plugins 
Chat 
 

WebEOC provides an instant message feed (i.e. Chat) tool.   

1. Select Chat from the Plugins menu 

 

 

2. The Chat board will be displayed.   The board will show all users currently logged into WebEOC. 

3. To chat directly with an individual, click on the Chat icon next to their name  . 

 

The Chat room will be displayed. 

 

Participants will be displayed on the left side: 
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4. Enter a message in the Compose a Message box and click the blue Send button to post the 
message. 

 

 

5. All messages entered by the participants will be listed in the order sent in the Messages box. The 
messages box will also log user activities: 

 

 

 
6. Participants can upload attachments by selecting “Upload Attachment” from the Action 

dropdown menu within the Message box. 

 

 

7. Personal settings can be adjusted for the chat room by clicking on the Actions tab in the upper 
left corner for the Chat screen  
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The following personal settings can be adjusted by checking and unchecking the box next to each 
feature: 

 

8. Click Save to activate the settings.  Click Cancel to cancel the changes. 

As chats take place, WebEOC creates a tab for each conversation along the Chat Menu Bar. 

 

 

 

9. Click the Tab to return to the Chat 
10. Click the X to remove a Chat.  Note:   If both parties remove a chat session.  The conversation 

will be deleted. Click Yes to confirm or No to cancel 
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Chat Rooms can be created for groups of people who need to keep in touch.   

Click the Chat Rooms tab to view all available chat rooms: 

 

 

To access (join) a chat room, click on the Chat Room name or on the Chat Icon   
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The following functions are available for each chat room: 

1. Join Chat    

2. Export the Chat to Excel or PDF    

3. Edit the Chat (Users, Positions, Groups, Title)   

4. Delete the Chat Room   

 

Note: Users must keep the Chat room(s) open and periodically check the inbox to review incoming 
messages.  This is not as effective as using other forms of messaging (face to face, phone calls, etc.).  For 
this reason, this tool may be discontinued. 

 

File and Map Library 
 

WebEOC provides a tool that allows users to upload files and documents.   Folders are created by the 
Administrator and are assigned to groups.   

1. Access the File and Map Library by selecting it from the Plugins menu 

 

2. Select and click on the desired folder from the list or user the Search (filter) tool to locate the 
folder: 
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3. The list of files will be displayed.   To locate a file, the user may scroll through the list or use the 
Search (filter) tool to locate the file.   

a. A file can be opened either by clicking on the link or clicking on the View icon next to the 
file name.     

 
b. The file will be downloaded to the desktop in its native format (Word, Excel, PDF, etc.) 

4. To add a file to a folder, click the desired folder and then click Add File   
5. Click on the Choose File box to select a file from the desktop or network drive 
6. Enter a Description of the file 

7. And then click the blue Save button to upload the file   
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WebEOC Help 
 

The WebEOC Help Center is access by clicking the Question Mark            icon located on the Menu 
Bar. 

 

 

A comprehensive list of topics is provided.   Click on the desired topic to access instructions and other 
helpful information. 
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